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General Operation of VM95 
 
A licensed version of Windows Embedded Standard 8 is installed on the computer. VM95 software, 
written by Erdman Video Systems, is the main application software and manages the majority of the 
systems capabilities such as scheduling digital capture and uploads. 
 
VM95 is a Microsoft Windows application developed, written, and maintained by EVS since 1995. There are 
2 modes or states that the program can be in, “Manual” and “Automatic.” When the program starts up, a 
screen is presented that says, “Click for Manual Control”. If you click on it, you enter manual control. 
 
In the Manual mode, you can test, configure, and program the operation of VM95. You can also view 
images from the local archive (hard disk), setting up and displaying composite images (composite 
images are any group of images, and are most often used to display panoramas consisting of 2 or 
more images). From Manual mode, one can launch the Automatic mode (under the File menu). The 
menus at the top will disappear and be replaced by one menu choice, “Stop Automatic”, which when 
clicked on will send you back to Manual mode. 
 
Automatic mode runs the ‘scenes’ (operations) specified in the Sample Schedule. The metaphor used 
here is that of a ‘Scene’. ‘Scenes’ are sampled (executed) regularly throughout the day and have “On” 
and “Off” times during the day. For example, “Scene 1” can be setup to turn on at 6:30 am and take a 
picture every 20 minutes until the “Off” time at 17:30 in the afternoon. When this “Scene” is 
sampled/executed, it snaps an image, downloads it from the camera to the computer, labels it, and 
saves it (archives it) to the local hard disk (and optionally to other hard drives). There are settings for 
what size of image you want, the quality, amount of disk space to use for the scene etc., all of which 
will be discussed in detail later. Another “Scene” operation can be an upload to the Internet. Here the 
various settings will involve whether to send a thumbnail, which FTP site to send the image, the name 
the image file should have at the FTP site, etc. 
 
In all, there are about 8 different types of ‘Scenes’ one can setup in the Sample Schedule, each having 
their own daily “On”, “Off”, and “Interval” times plus many other parameters depending on the 
operation performed by the ‘Scene’. We have mentioned” , Image Capture, and Image Uploading. 
Other “Scenes” include AutoPan Image Capture, Video Capture, measuring temperature and voltage, 
different types of Internet Uploading, and even rebooting the system. 
 
The Sampling Schedule (under the Setup menu) is where the scenes are setup. Information that is 
common to all scenes or independent of the scenes is setup in the ‘Options’ (also under the Setup 
menu). Here things like Station Name, cameras, FTP sites, Email warnings, and many other parameters 
can be configured. 
 
When everything is setup properly, automatic mode can be launched and the various scenes will be                               
executed throughout the day according to the Sample Schedule. 
 
VM95 operates in conjunction with the EVS Board. This board controls the power to the computer and 
to the cameras, toggling them when necessary. The EVS Board also communicates through a serial 
port with the computer and serves as a ‘watchdog’ for the VM95 program. 
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The Main Screen 

 
Fig 2.a The main screen when you enter Manual mode. The left column of the screen changes depending on which options 

have been selected, e.g., with or without video, with or without digital cameras and with or without a pan tilt unit. 
 
There are 4 main quadrants one can see above. The upper left quadrant is used for displaying live 
video signals and is also used for temporarily holding images when they are being processed, as in the 
case of labeling and resizing the image. The other 3 windows are image buffers. After acquiring and 
processing an image, it is loaded into one of these windows before it is archived. You can also load 
your own images into these windows. You can zoom in on the images in these 3 buffers simply by 
“drawing” a box (click the left mouse button, and while holding it down, move the mouse: you will see a 
box being drawn, and when you release the mouse button, the image will be zoomed to that portion). 
A zoomed image will have horizontal and vertical scroll bars to let you move about in the image. To 
zoom all the way out, press the “x” key on the keyboard. You can also see a full screen image by 
double clicking on the image. To return to the normal view, double click again on the full screen image. 
In addition, you can increase the brightness, contrast and sharpness of the image but pressing the “b”, 
“c” and “s” keys respectively. To reduce the brightness, contrast and sharpness, hold down the “Shift” 
key while pressing “b”, “c” or “s”. To return to the original setting, press the “r” key. Two more image 
attributes can be obtained by selecting one of the last 2 menu choices under the “View/Edit” menu. 
“Show Image Dimensions” and “Compute Image Brightness” can be very useful in certain cases. 
“Compute Image Brightness” performs a calculation on the image that gives you one number 
representing the average brightness of the image. The value goes from 0 (black) to 255 (white). There 
are a couple programmable settings in the Sample Schedule that, when acquiring images, allow you to 
specify the average brightness desired for the image to be captured. When making movies or time 
lapse sequences, having images of all the same brightness can enhance the viewability of the 
sequence. 
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Manual Control 

 
Fig 2.b The camera settings for snap are only used for manual testing 

The camera snap settings are used for manually testing camera sample settings or for focusing the 
lens of the camera. These settings do not apply to the automatic mode settings that are set in the 
sampling schedule. Some form items will not be available based on the setting on the camera body. 
Also, note that some lenses do not focus using these controls. Lenses that do focus are usually STM or 
USM ring motor type lenses with full time manual control. You can quickly tell if you set the lens to 
manual mode and attempt to move the focus. If you see it change then the focus can be controlled.   

Testing scenes 
You can test the scenes choosing ‘Test Capture and Label’ under the Test Capture menu. The image 
captured will be displayed in one of the 3 buffers. The last buffer you clicked on will be the buffer used 
for the new image. 
 
Below the bottom two buffers, there is space for a message. This is used to display the status of 
various operations and to display messages that can alert the user to unusual conditions. 
 
Below this status line are a few check boxes: 
 
“View Sample List”: During Automatic mode, a list of all the scenes to be sampled is displayed. 
Sometimes you don’t want to see this and you just want to see the images. Unchecking this box will 
hide this sample list. 
 
“Rotate Capture Windows”: In Automatic mode, a check in this box will load the captured images into 
successive buffers, so you would be able to see that last 3 images capture. This is convenient 
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sometimes but can reduce system performance if you are capturing high resolution images, so it’s best 
to leave this unchecked for normal operations. 
 
“Enable Internet”: This check box directly affects whether the system will attempt to do uploads to the 
Internet or not. If it is unchecked, the system will not attempt to connect to the internet, either in both 
Manual and Automatic mode. If you or the program attempt to upload to the Internet, and this box is 
not checked, you will see a message on the Status Line alerting you to this condition. 
 
“Run Minimized”: this should not be checked and has been disabled in recent versions of VM95. 

System Options 
 
To pull up the “Options” form from Manual mode, click on “SetUp” and then on “Options”. 

General Options 

 
 

Fig 3.a The “Options” form. This is the General Tab that one sees when first entering the “Options” form. To see the other 
groups of options, click on the desired heading in the white list box in the upper left. 
 
System Type: “Fixed Camera Station” is a system with no pan and tilt motor. “Pan/Tilt Camera Station” 
is a special type of system with a positioning motor. 
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Station Name: This is the station name passed to the server when processing uploads. This should not 
be changed from the factory default. 
 
Enable Video Server (wvcc): Check this for systems with video capture ability. 
 
Slow Frame Rates: This will lower the load on the cpu. Check the task manager to see if cpu usage is 
too high, and check this option if it is too high. 
 
Solar Powered System: This option changes the way some of the power saving features work. Most 
reboot conditions are ignored since the system will most likely shut down itself anyway. Log files are 
kept to a smaller size. The Watchdog time is set to 5 minutes (instead of 60 minutes). It is not essential 
to check this when using a solar system. 
 
Min brightness: This option tells the software to NOT save (ie., archive) any captured image that has an 
average brightness less than the value you enter. Brightness values can range from 0 (black) to 255 
(white). Typical day time images have an average brightness around 100 – 140. Night time images can 
be as low as 50 and still show some details. We recommend a value of about 40 to avoid having 
unsightly dark images on your web page that remain there until the next morning. 
 
Save Canon Images: This is a special way to snap and collect images using the Canon EOS shutter 
release port and an SD card. While the computer is off, the Controller board snaps pictures on the 
digital camera. When the computer wakes up, the images on the memory card will be archived (and 
optionally labeled) to the hard disk as scene 5. In this case, Scene 5 is reserved and must be set up 
with your desired capture settings. 
 
Long Exposure White Balance: used by EVS for special imaging needs. 
 
Use new CHDKlib: used by EVS for special configurations, normally not checked. 
 
Cycle Cam power at startup: Normally not checked. If the system is in a 2pc configuration and the 
remote side CamPower is used to power USB extender devices, sometimes it’s required to toggle the 
power to these units to get them to perform reliably. Check this box to do this. 
 
IR Illuminator Enable: used by EVS for special imaging needs. 
 
Enable Fast Snap: This option skips showing captured images in the quadrants in order to speed up 
the capture rate. If an overlay is set for the capture, this option is ignored. 
 
Check URL for Wipe_s#.txt: Check this to have the system check a webpage for a windshield wipe 
request. 
 
URL for wipe file: This is the URL checked in order to trigger a wipe. 
 
Make MP4 instead of WMV: Use this option to create MP4 files when capturing a video. 
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Master Slave Disk Control: used by EVS for older system configurations, normally not checked on 
newer systems. 
 
Upload High Res images only: This option will skip the creation of all thumbnail files at the camera 
station and attempt to trigger a remote script at the server to create the thumbnails. This is always left 
on when using EVS webhosting services. 
 
Digitize Enabled: Normally checked. On pan tilt systems, it’s sometimes useful to run the schedule 
without digitizing to see how it moves to the various positions. 
 
Internet Enabled: Normally checked. Un-checking this allows you to run through a schedule while 
skipping over the uploads. Note that there is also checkbox at the bottom of the main screen that is 
also labeled 'Enable Internet': It has the same function and is more accessible. 
 
Enable Blind Positioning: used by EVS for special imaging needs. 
 
Use temporary file name: This option causes the software to send all files (when doing an FTP) using a 
temporary file name and then renaming it once it’s all there. This addresses 2 issues: 1) For those 
viewing the web page that contains the uploading image, this option keeps the viewer from seeing a 
partial image on the web or from getting the 'x' where the image should be, since (assuming you're 
using a static filename) while the image is being uploaded, the image is not available for viewers who 
try to see it. 2) The other issue concerns FTP Servers, such as IIS Version 4, which do not allow 
overwriting a file if any web browser has viewed the image in the last few minutes, but, oddly enough, 
it will let you rename it. 
 
Enable EOS or PTP Streaming: used by EVS for special configurations, normally not checked 
 
Do not check for file existence during FTP: Normally not checked. Some FTP servers seem to 
disconnect the user when a specific file is looked for in an empty directory, and this causes an 
unsuccessful upload. Note that checking the box cannot hurt anything: At worst, a file is uploaded that 
was already uploaded previously. 
 
Use (new) long Thumbnail names: Thumbnail filenames created for Internet uploading use 8 character 
filenames, and since the date and time are encoded into the filenames, times are resolved only to the 
minute. With this box checked, thumbnail filenames use the same name as the high resolution file, with 
'_tn' appended to the end. This could create problems if you already have old thumbnails uploaded, in 
that, for example, slide shows may not work properly anymore. Not normally checked. 
 
Do Focus Correction: This option is moved into the -98 capture scenes for all new versions.  
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Pan Tilt Options 

 
 

Fig 3.b Pan/Tilt options allow you to correct (in software) for various types of wiring in which either the motor wires or the 
feedback pot wires are reversed. 

 
This settings panel is used to calibrate a Pan and Tilt motor when the system comes with such a 
device. These setting should not be adjusted by the user. 
 
The check box labeled “Two Pan/Tilts or Zoom/Focus System” is for custom applications. 
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Controller Options 

 
 

Fig 3.c Options for the ‘Controller’ refer to the EVS NanoTL Controller Board. 
 
The Controller options are used to configure VM95 to be able to communicate with the EVS Controller 
Board. Most of these options will come pre-configured and should not be changed. 
 
Watchdog TimeOut Time : This is the amount of time before the watchdog will reboot the system. This 
only happens when the system is in manual mode and no activity is happening in the software. This is 
useful if the system is installed in the field and forgets to put the system back into “automatic mode”. It 
also prevents the system from becoming locked up more than the set number of minutes. 20 minutes 
is a standard choice. 
 
Pan Tilt positioning tolerance: This refers to the acceptable error when positioning the pan tilt. Setting 
this to 8 is standard. Pan tilt positions are read to an accuracy of 15 bits, which, given the way the 
electronics are designed, gives a resolution of 1 part in 32768 for the range of motion (360° for the pan 
and 180° for the tilt). Translated into degrees, this is a bit less than 0.02 degrees. The actual positioning 
accuracy is worse than this due to electrical noise and mechanical play, and we have determined that 
the accuracy is between 0.1 and 0.2 degrees, about 10 times better than typical security pan tilt 
systems. 
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Windshield Wiper Control Values: These settings are used to adjust the wiper and pump times in 
windshield wiper enabled systems. 
 
Enable Pre-Heat: This is used in cold weather applications in order to pulse a heater before the system 
powers on and boots. This is a custom application. 
 

Video Cameras 

 
 

Fig 3.d Video camera types include uEye cameras and Sensoray video digitizers and Canon Powershot type cameras. Be 
sure to also check the ‘Enable Video Server’ check box under the General Options. 

 
These settings will come pre-configured if you have ordered a video type system.  
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Digital Cameras 

 
Fig 3.e Up to 4 Canon cameras are supported with the software. When using Canon SLR cameras, you MUST enter the 
word EOS into the Name field, otherwise a PowerShot camera is assumed and the camera will not initialize properly. 
 
 
Enter up to 4 Canon cameras here. 
 
On PanTilt: This must be checked if the camera is on a pan and tilt positioner.  
 
EOS 5D: This is checked only if the camera is a large body type Canon. This only alters the way the 
camera is power toggled 
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Dial-up Options 

 
Fig 2.8 Normally the Constant Net connection is checked, even if using a dialup since XP handles the connection 
automatically. The Reestablish lost ISP Connection is used only in custom applications and is normally unchecked. 

 
Constant Net Connection: Leave this checked. 
 
Reestablish lost ISP connection: used by EVS for special configurations, normally not checked. 
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FTP Options 

 
Fig 3.f.1 You can have up to 10 FTP profiles. 

 
To add or change an FTP site address, double click on an entry in the list box near the top of the form. 
You can also double click on a blank line there also. This will prompt you to type in the new address for 
the site.  
 
FTP Profile: This is the friendly name of the current profile.  
 
FTP Address: This the URL or IP address of the FTP server.  
 
User Name and Password: This is the username and password for the current profile. 
 
Starting Directory: This is the path to the camera archive folder. If blank, the root or home folder of the 
FTP login will be used. 
 
Prefix for naming DateTime Images: Leave this blank. Used by EVS for special configurations, normally 
not checked. 
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There is another tab on the FTP Options called ‘FTP Options’. Click on it and you should see the 
following screen: 

 
Fig 3.f.2 Additional FTP options. 

 
Maximum # of files to keep on Server: If the “Do not delete files at the FTP site” check box is NOT 
checked, this is the number of files that the system will keep at the server. In other words, the oldest 
files will be deleted at the server in order to always keep room for X number of files. 
 
Timeout for “Stay-on-Line” is a feature used in conjunction with Internet control of systems that use a 
Dial-Up to connect to the Internet. Leave it set for 120 seconds. 
 
Default Timeout: FTP connections can sometimes hang in the middle of a file transfer and never come 
back to life. The computer doesn’t crash, but the FTP operation seems to die. During FTP file transfers, 
VM95 will only wait a certain amount of time before it gives up and aborts the FTP process. The 
amount of time it waits is set here in seconds. 60 seconds is the recommended value for dial up 
connections, and for higher speed connections, one could lower this value to 30 seconds. Perhaps 
most useful in the case of really slow, one could up this value to 120 seconds. 
 
Check for for_vms directory: The for_vms directory is a special directory located at the FTP site to 
which you are uploading, and is used as a folder to hold files that you want to send to the VM95 
camera station. The “vms” in for_vms stands for “​v ​ideo ​m ​onitoring ​s​tation”. And any files placed in this 
directory are “for” the “vms” station. Files in this directory are copied into the c:\vm95 folder. 
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Send/Remove IP address:. The current IP address is written in a small text file called “ip.txt” and is put 
in the “from_vms” directory under the archive directory at the FTP site. This file gets written as soon as 
an FTP connection is made.  

Archive Options 

 
Fig 3.g The Archive options: The archive directory name is where all your imagery is stored locally and is also used a the 

remote site where the images are uploaded. 
 
Archive Directory: This is a required field. This is the directory into which the camera images are 
stored. Subfolders are created here based on the “max number of files per directory” input box at the 
bottom of the window. 
 
The 2nd and 3rd Archive directories: These are optional directories which can be used to mirror the 
archive of images, or for backup to an external hard drive. It can be turned on and off depending on 
the capture scene. 
 
Use Simplified Date/Time Names: Not normally used. 
 
Create a new subdir for every day(used to be month): this will create a new folder per day instead of 
counting files. 
 
Save to the Argus Standard: Not normally used. This is for a special application. 
 
Total Number of Drives was used: Not normally used. Legacy setting. 
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Advanced Options 

 
FIG 3.h Most of the options here are pre-configured and many are for custom applications. 

 
Thumbnail Image Compression for Uploading: This setting determines how much to compress the 
thumbnail images (that are made from images in the archive) for uploading to the Internet. If you want 
really crisp, detailed thumbnails, set this value to around 90. Typical (good) compression is about 75 
and if you want the smallest, yet relatively good, thumbnail images, set this value to around 50. 
 
Analog Channel Setup and Calibration: On the right side of the Advanced Options form, you can 
choose a channel (from 1 to 8) and read values, and calibrate the raw values to get meaningful 
numbers. Click on “Read Raw Value Now” and the channel that is selected will be read and displayed, 
along with the converted value if you have entered calibration number. The calibration numbers are 
nothing more than 2 values for the sensor. For the included temperature sensor, this consists of 2 
points, one at freezing and one at boiling temperature. Assuming a linear relationship (y=ax+b), the 2 
points allow the sensor to be calibrated. The 2 text boxes labeled “Description and Units” are used in 
making plots and in labeling the text file into which the data are written. When you sample the analog 
sensors, (using a –101 in the Sample Schedule), the data get written into a text file under the c:\vm95 
directory, called adc.txt. This text file is then used when plots are requested (using a –102). See the 
“Sample Schedule” for more information on this. 
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Alert/Email Options 

 
Fig 3.i Alert and Email Options. 

 
Error Reporting and Email Notification: This is the address of the alerts processing script at a remote 
server. By default, EVS provides its own servers to handle alerts.  
 
SMS: This feature is disabled.  
 
Email: Enter the email addresses in the text input separated by commas. Ex: 
“evs_staff@video-monitoring.com,sales@video-monitoring.com”. The buttons below will send out test 
email messages to the corresponding addresses. 
 
The third type of notification is operational data sent to EVSCenter. This database is monitored by EVS 
for any possible errors. This type of error reporting is only sent to EVS and not the user. EVSCenter 
only receives the same type of notices that are sent to the user. 
 
   

VM95 Reference Manual – Version 36h  
© Erdman Video Systems, Inc. | 8895 SW 129​th​ Street, Miami, FL 33176 | Tel: 1-888-495-6057 

 



Programming the Sample Schedule 
 
The Sample Schedule is where most of the programming is done once the system has been initially 
setup. As mentioned earlier, a metaphor for the sampling schedule is “Scenes”. Each “Scene” has a 
daily On and Off time and an Interval (the Internal determines at what interval during the “On” time that 
the scene gets sampled). Sampling a “scene” involves executing what the scene is setup to do. There 
are 11 different operations a “scene” can do; they are:  
 

● -0  Video Image Capture 
● -96 Video Clip Capture 
● -98 Digital Image Capture 
● -99 AutoPan Image Capture 
● -998  Composite upload to the Internet  
● -997  Single Scene upload to the Internet  
● -101  Sample the analog channel 
● -102  Make plots of the weather or analog data  
● -995  Timelapse sequence upload to the Internet 
● -994  Make an Mpeg movie and/or make and save composite images  
● -999 Reboot, sleep, or restart the software. 

 
The number in bold is simply an abbreviation for the scene. It is used as a shorthand method to refer to 
a scene’s operation. 
 
A note about Composite images: One of the unusual strengths of VM95 is the way it can handle 
composite images. A composite image is any collection of images, from 1 to more than 9 images, that is 
defined in the “Composite Image layout”. For example, when using a pan/tilt unit, you may want to do a 
panorama consisting of 5 images from left to right. You could use a –99 (autopan image capture) to 
acquire the images and store them in the archive locally. You would define a 5 column, single row 
composite in the “Composite Image Layout” that would point to the 5 scenes captured with the –99. 
Then in order to upload these to the Internet, you would use a –998, in which you would simply 
reference the composite layout you defined, and all the details of gathering the files, making 
thumbnails, naming them, laying them out on the web page, etc would be taken care of automatically. 
 
Archiving: Images are archived to the local hard disk whenever they are sampled. That is, when you do 
an image capture via a -98, -99, -96 or a -0 operation, the captured image is archived in a specific 
directory structure. An example will illustrate this: Use “pics” for the archive directory and set up Scene 
1 to be a -98, a Digital Camera Capture. The very first time you sample this image in automatic mode, 
(or if you do Menu->Test->Test Capture, Label and Archive”), a series of subdirectories will be created 
under c:\pics. If today’s date is March 21 2009, then the image acquired will be saved as 
c:\pics\s1\mar2109k\m211130a.jpg The various subdirectories have the shown name because: 
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● “C:\pics” this is the archive directory name you set in Options (see section 3.g) 
● “s1” this is used because the sample was setup in Scene 1 (of the Sample Schedule) 
● “mar2109k” mar21 stands for March 21, 09 stands for year 2009, and the k at the end represents 

the hour of the day that this directory was created (a-w represent hour 0 – 23 respectively) 
● m211130a.jpg this is the filename for the captured image; m21 stands for March 21, 1130 stands 

for 11:30 in the morning, and the “a” represents the “seconds” of the time the image was 
captured. The letters a-z represent the number of seconds from 0 to 59. The letter used for the 
month is: 

 
● j = January 
● f = February 
● m = March 
● a = April 
● y = May 
● u = June 
● l = July 
● g = August 
● s = September 
● o = October 
● n = November 
● d = December 

 
 
 
 
The use of the intermediate sub directory called mar2101k in the above example is needed in order to 
keep the number of files in any one directory from getting too large and unmanageable. The date 
encoded into this subdirectory corresponds to the first file written into the subdirectory. When the total 
number of images exceeds the number set in “Options > Archive”(See section 3.g) the archiving 
operation automatically creates a new subdirectory, using the date/time from the image to be saved. 
 
New subdirectories are created every 3 months starting with January if the number set in “Options > 
Archive” is not reached. 
 

● “s” scenes are used for standard capture scenes  
● “p” scenes are used for auto pan scenes 
● “d” scenes are used for post processed scenes such as making a panorama, resizing, etc 
● “v” scenes are for saved time lapse movies in .wmv or .mp4 format. 
● “c” scenes are for RAW files 
● “f” scenes are for saved variance images (using video or ueye cameras). 
● “x” scenes are for saved pixel extraction/time stack images in .bmp format. 
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Overview 

 

Fig 4.a An example screen of what you see when you first enter the Sample Schedule. Here we see the General tab of a 
–98 operation 

 
On the left side, in the white list box with the vertical scroll bar, is a listing of the 80 “scenes” that can 
be programmed, S1 through S80. The Scenes with a green dot next to them are the scenes that are 
currently active, indicated by the fact that they have a non-zero Sample Interval. To deactivate a scene, 
so it won’t get sampled, you must set the Sample Interval to 0. A Sample Schedule with no green dots 
will not do anything when it is put into automatic mode. It will simply flash a message on the Status Line 
that there are no scenes to sample. To the right of each scene number is a number in parentheses, 
which is the code for the scene operation, allowing you to quickly recognize where the different scene 
operations are situated. 
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Buttons along the Bottom: 
 
 
 
Save/Return: saves all changes you made.  
 
Cancel/Return: does not save any of the changes you made 
 
Table View: saves your changes and presents all the data in a spreadsheet like structure which can be 
very useful in making global changes, and reorganizing the scene order. 
 
Save Schedule: This lets you save all the scene parameters in a text file of your naming, with the 
extension .sch. It is useful for saving complete setups, and then reloading them at a latter time. We also 
provide some pre-written sample schedule that you can load and see how certain things are 
accomplished.  
 
Load Schedule: This is for reloading a pre-written or previously saved sample schedule. 
 
Wizard: Walks you thru some basic setup scenarios and pre loads some of the fields for you after 
you’ve selected a number of options. 

Picking the operation for the scene 

 
Fig 4.b The drop down list for the “Operation to be performed” 

 
At the center top of Fig 4.a, you see “Scene Number 1”, corresponding to S1 at the left in the white list 
box. Right below this is the “Operation to be performed”, which you can choose using the drop down 
list box.  
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Scene Intervals 

 
Fig 4.a Again 

 
In Fig 4.a, you see the operation is a -98, which is a Digital Camera Acquisition operation. There are 
four tabs that need to be set up, or at least checked, for proper operation. The tab we see is the 
“General” tab. This tab is very similar for all different scene types since all operations will have an “On” 
time, “Off” time and an “Interval”. 
 
Interval, On and Off: The “On” and “Off” time should always be in the 24 hour format and should 
always consist of 4 digits with a colon (:) in the middle, such as 17:35 or 06:45. You can type in the time 
value without the colon and it will be automatically formatted with the colon for you. The “Interval” is in 
minutes and represents the amount of time before the operation is repeated, assuming that the time is 
in the “On” period. Scenes that should be sampled every 15 minutes between 7 in the morning and 7 in 
the afternoon are easy to set up: 
 
Interval=15 
On time=07:00 
Off time=19:00 
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What about samples that should start late at night and turn off in the morning? Lets say you want to                                       
take pictures of a parking lot from 9 pm to 6 am every 5 minutes. Set up the parameters as follows: 
 
Interval=5 
On time=21:00 
Off time=06:00 
 
The program logic is such that, when it sees an “Off” time that is less than the “On” time, it will assume                                           
you are sampling through the night and into the next day. 
 
If you want to sample continuously, set the “On” time to “00:00” and the “Off” time to “24:00”. An                                     
Interval more than 1 day (1440 minutes) is acceptable, but it is probably more reasonable just to disable                                   
certain days. 
 
On the Minute: This is a feature that can be quite useful, but can be a bit confusing at first. To 
understand why it’s needed, you need to understand how the program determines which scene to 
sample next. Suppose you have programmed up 5 scenes to take pictures and upload images every 
20 minutes. Let’s say you start them all at 7:30 am and turn them off at 17:30. When automatic mode 
starts up, it scans through the list of scenes and computes the next sample time for each scene. In our 
example, all 5 scenes would be set to sample immediately, assuming it’s after 7:30 and before 17:30. 
So it “samples” them in the order that they are in, since they have the same first sample time. When it 
finishes sampling a scene, it computes the next sample time for that scene by adding the interval to its 
current​ time. It does not add 20 minutes to the scheduled time, but rather to the current time when it 
sample the scene. In this way, the scenes will get naturally staggered out in time. Some operations you 
just don’t know how long they will take, like uploads to the internet, so this strategy ends up working 
quite well. In certain cases, though, you may want the samples to occur at a very specific time, like at 
the top of each hour. For example, say you want to capture an image at 8:00, 9:00 … until 17:00. You 
could set it up as follows: 
 
On time = 8:00 
Off time = 17:15 
Interval= 60 
On the minute=checked 
Tolerance=10 minutes 
 
The time 17:15 was used so it will sample at 17:00, otherwise it might start at a second past 17:00 and 
decide it’s outside the desired sampling on/off times. With “On the Minute” checked, only samples at 
the top of the hour will be taken. The tolerance is a needed parameter that tells the software how 
many minutes it can be late and still be required to take the sample. For example, if you start up the 
automatic mode at 11:05, you will not get your first sample, unless the tolerance is 5 minutes or greater. 
Or similarly, if another operation takes so long that its already 12:07 before it finishes, a sample with the 
tolerance set for 10 minutes will still take place, since 12:07 is within 7 minutes of the actually 
scheduled time. Do not set the tolerance to be greater than the Interval. 
 
Since the “On the Minute” scenes take precedence over the regular scenes (which do not have “On 
the Minute” checked), you could get stuck sampling only one scene the whole time if your tolerance is 
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larger than the Interval. As a general rule, we recommend making the tolerance about ¼ or less than 
the Interval, 
 
If you are not sure whether you need “On the Minute”, it’s best to leave it unchecked. 
 
Day of the Week: These check boxes let you turn on and off the sampling for various days of the week.                                         
If none of them are checked, the scene will never be sampled. 
 
Up to this point, the comments made regarding Fig 4.a are the same for all scenes. They all have on, 
off, interval and on the minute parameters.  

Capturing an Image 

General Tab 
Fig 4.a is a -98, that is, a Digital Camera Acquisition scene.  
 
Zoom: this can be set for 0 for wide angle to 13 zoomed (only for Canon Powershot type cameras). 
 
Pause before taking the shot: This option will wait X number of seconds before taking the shot. 
 
Save Image under a different scene Number: This can be extremely useful in certain cases, especially 
when you need to program many scenes to accomplish the sampling of a certain process in the 
manner you want. For example, let’s say you just want to take shots during rush hour traffic, from 7:00 
– 9:00 am and from 15:00 – 18:00 daily. You can easily program up two scenes to do this. But if you 
want to make a slideshow showing both sets of images in the same slideshow, you’d have difficulty 
because the images from the morning are saved in a different directory than the images from the 
afternoon. Simply checking this check box for the afternoon shots, and choosing the scene number for 
the morning shots, would put all the rush hour shots in the same directory, and you would not have to 
concern yourself with dealing with 2 different sets of images, since they are all saved under a single 
“S” directory. 
 
Setting the Pan Tilt Zoom values: For the pan and tilt values, one is permitted to type in values, but 
often the values are input directly when you invoke the Menu choice “Pan/Tilt” – “Set Scene at Current 
Position” and choose the scene number to load the values into. This way you can position the pan tilt, 
try a few test captures to make sure the image is framed the way you want it, and then save the 
position and zoom information using the “Set Scene at Current Position” function.   
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Capture Tab 
Here is where you set all your camera capture settings. Note: some fields may not be available based 
on the mode your camera is in. The individual options will have different settings based on the camera 
body and lens you are using. 

 
Fig. 4.c The Capture tab for the -98 digital camera acquisition scene 

 
Choose the camera to use: The list you see in the drop down for camera selection comes from the set 
of “Enabled” cameras that have been set up in Options > Digital Cameras (see Fig 3.e). 
 
Resolution: Here you will select the resolution of the picture as captured from the camera. Different 
camera models will present different options. Usually, there will be: Large, Medium, and Small available 
 
Exposure: Use this to pick Automatic Exp. or Manual Exp. Seek proper exposure is for special 
applications. Only used in Tv and Manual. 
 
Exposure Comp: Use this is the stop up or down the exp. 
 
ISO: Use this to increase the light sensitivity 
 
Aperture Priority: Used to open and close the aperture on the lens. Use this only in Av and Manual 

VM95 Reference Manual – Version 36h  
© Erdman Video Systems, Inc. | 8895 SW 129​th​ Street, Miami, FL 33176 | Tel: 1-888-495-6057 

 



 
White Balance: Used to pick the color temperature of the scene. 
 
Picture Quality: This is the JPEG compression level performed in the Canon body. Usually corresponds 
to Super Fine, Fine, and Normal. 
 
Focus Correction: Use this to correct focus before taking each shot. Enter the number of small nudges 
from the end(infinity side) of the focus range of your lens. You can count these with the EOS Utility app 
from Canon or other freeware apps like the APT- Astro Photography Tool.  

Overlay Tab 

 
Fig 4.d In the Overlay tab, you specify the text, text attributes, and location to write text directly on the captured image prior 

to archiving. 
 
Text can be overlaid directly onto the image (as a bitmap) before it is archived. The default position for                                     
the text is in the upper left corner. There are a number of special codes that allow you to change font                                         
position, color, font, and size, and even allow you to plot limited graphics on the image. The codes all                                     
begin with a backslash,”\”. To see the list of codes, click on “Insert Codes”. For example, to begin                                   
writing text near the bottom, you specify in the text, the code “\ct560” (do not put in the quotes). This                                       
code stands for “​c ​hange ​t ​op” to 560 where 560 is the y pixel coordinate (0,0 is assumed always to be                                       
in the upper left corner). If the image you are writing onto has the dimension 800x600, then y=560 will                                     
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move the starting line down near the bottom. There are more than 30 codes, making it sort of a                                     
scripting language for text overlay. The set of codes won’t all be discussed here, but note that when                                   
looking at the code list, at it says \ct### where ### is a number, be sure to include all 3 digits of the                                             
###. For example, to “change the top” to pixel 8, you would have to write “ct008”….it is necessary to                                     
pad the 8 with two 0’s to have this code properly executed. The most used code is the “\d” code,                                       
which writes the date and time on the image. “\n” starts a new line. “\K” writes a string of capture data                                         
from the Kodak camera indicating exposure time, white balance etc. “\k” only write the exposure time. 
 
 
 
Size, color, and style are self-evident. We have found that “Bright yellow” or “Bright White” used with 
“Black Outline” gives a very pleasing overlay. 
 
Click on ‘Insert Codes’ to see a list of all possible codes used in setting up the overlay. 
 
Rotate and Crop: When you check the Rotate and Crop checkbox, you will see the following form to 
input some parameters: 

 
Fig 4.e Rotate and Crop parameters. 

 
Rotate and Crop can turn an awkward looking image into a well laid out image when used properly. 
The “crop” or cropped image is the cut-out part of the image that is saved. The crops here must be 
rectangular, but can have any x (width) and y (height) dimensions. The angle of rotation is positive 
clockwise, and can be specified to a precision of 10ths of a degree. The x,y coordinate system is in 
(horizontal, vertical) pixels and assumes that 0,0 is in the upper left corner. Rotating takes place before 
cropping. The upper left corner of the desired crop is given by the parameters “Left” and “Top”.. The 
cut-out width and height are also specified as parameters. It’s up to you to make sure the parameters 
make sense…for example you cannot set the left and top parameters to be the lower right corner of the 
image. It is convenient to use a single aspect ratio, since this must be known if you make thumbnails 
for the Internet. Aspect ratio of 3:2 (horizontal : vertical) is recommended. 
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Archive Tab 

 
Fig 4.f The Archiving tab lets you control the quality of the saved image, how much local disk space to use for the scene 

and more. 
 
All images that are captured get archived. You can set a size limit on how much space you want the 
scene to occupy on the local hard disk. Once the size of all the images in the scene exceeds the 
number of Megabytes you specify, the oldest images will get deleted to maintain to total space usage 
under the limit you set. Images on the 2nd, 3rd and 4th archive never get deleted. Managing their disk 
space is up to you. 
 
The Jpeg quality when we save the image (after resizing and labeling the captured image) can be set 
from 0-100. Setting it to 0 is interpreted as setting it to the default value which is 75 in this case. “100” 
results in a near perfect image whose size is about ½ the size of the equivalent 24 bit color, bitmap 
image. A value is 75 gives you a compression of around 10-20, and has only a slight visual artifacts that 
become more and more evident as you zoom in on the image. A value a 50 will result in a very small 
file size, but artifacts of the compression (blocky and patchy looking, with distinct horizontal and 
vertical lines with lengths in multiples of 8 pixels) will be apparent. NOTE: compression is not used if 
there is NO image manipulation performed. That includes, overlays, rotating, cropping, etc. 
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Save to 2nd, 3rd and 4th archives: In the “Options” “Archive” setting, you can specify a 2nd, 3rd and 
4th archive, which can be any device that Windows can write to, and for which it has a drive letter. If 
one or all are specified, and you have checked this box, then, besides saving the image in the main 
archive, it will get saved identically in the 2nd, 3rd and 4th archive. 
 
In addition, save image to a specified file name: Sometimes it is convenient to have the latest image 
captured saved somewhere with a fixed filename, which gets overwritten each time the image is 
sampled and archived. You can specify the drive letter, path and filename, or if you just specify the 
filename, it will save the file in the directory from where VM95 is running (usually c:\vm95) 

Uploading Images 
It is assumed that you have configured access to the Internet, and access to the FTP sites in the                                     
Options form. If you haven’t, go to the Options form in Section 3 
 
There are 3 scene operations that do Internet upload:  
 
-997 single file upload 
-998  composite upload 
-995  time lapse sequence upload 
 
All three of these operations share the same “General” Tab: 

 
Fig 4.g The General tab that is the same for all Upload operations. 
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There is only one new field we’ve haven’t seen here. It is the checkbox labeled “Do Not Call ISP for                                       
Uploading, use the local LAN. This was needed to support older dial up connections and is no longer                                   
used. 
 
Also in common for all three types of uploads, is the MultiFile Upload tab: 

 
Fig 4.h The Multi-file options allow you to send a list of files from the local machine to an FTP site. 

 
MultiFile operations were created to address the need of sending a list of existing files from the local 
computer to the FTP site, allowing you to set the path and filename at the destination site. We use this 
principally for sending our diagnostic files to the Internet so they can be accessed and checked 
without disturbing the camera system. A number of our clients use this to send data files from one 
location to another on their LAN at a regular schedule. 
 
There are 4 ascii files that can be viewed and edited with any text editor (notepad or write). Any of the 
3 upload operations can be requested to send one of these 4 files at the end of its upload operation. 
The 4 ascii files are found in the application directory (usually c:\vm95) and are called mf1.txt, mf2.txt, 
mft3.txt and mf4.txt. Fig 4.i shows an example of mf1.txt loaded with the usual set of diagnostic files we 
like to upload. Each line consist of 2 complete path and filenames separated by a comma. The first 
path filename is the local file on the computer, and the second file name is for the destination at the 
FTP site, relative to its starting directory. Note that use of backslash for the local file and forward slash 
for the Internet file. 
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Fig 4.i An example of mf1.txt showing a list of diagnostic files to upload. 

 

Uploading tab 

 
Fig 4.j Here we can select some general options for uploading the image set 
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Name of FTP site: This will contain a list of FTP sites as setup in Options > FTP (see section 3). This is 
the FTP site that the scene will upload to. 
 
HTML fields can be ignored. They are for legacy applications. 
 
Slideshow file name: This is the name for the ascii reference file that can accompany the images. It is 
recommended that you check “Silverlight txt file” check box. If you don’t the reference file is overly 
verbose.  
 
Append to Slideshow: Use this to append the new images to the current slideshow txt reference file. A 
max number of files can be set by clicking “set”. If this is unchecked, the txt file will only include what 
was uploaded.  
 
Upload just the thumbnails: This check box will force the upload to skip the high resolution files when 
uploading. 
 
Use Static Names: If this radio button is selected, the images will be uploaded as a sequence such as 
pic001, pic002 etc…. This is generally not used. -995 is almost always used for dynamically named 
images. 

Image Layout Tab 

 
Fig 4.k The image layout tab is for setup of thumbnails for upload. 
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Keep existing images or thumbnails: Keep this checked. Set the thumbnail size in the width and height 
boxes. 
 
The rest of the options here are legacy. 

Image selection 

 
Fig 4.L Img selection tab is used to pick which scene to upload 

Pick the scene type and number here.  
 
Duration is how far back into the archive to upload. 
 
Start hour: this is used to pick the starting hour when the duration is set to days, not minutes.  
 
Interval: this is used to upload only a subset of images.  
 
Impose min file size: this can be used to skip files that are too small such as dark/black images. 
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Other Scene types 
There are many other scene types.  

 
-999 is the most commonly used other scene. It can be used to sleep the system between shots, 
reboot or restart the software at scheduled times. If attempting to sleep the system and a -1 is used for 
the shutdown time, the scene hour on and off of the scene is used. Otherwise the system will sleep for 
the designated number of minutes.  
 
A Quick hard reboot will power cycle all attached hardware power cycle the pc card.  
A Reboot will only restart the windows operating system 
Restarting VM95 will only restart the VM95 program.   
 
A quick note on using a -999 scene. All the intervals of all the other scenes are reset once the software 
is restarted. If this scene is included during mage sampling time ranges, those scenes will restart the 
intervals once the system and software is restarted. 
 
 
   

VM95 Reference Manual – Version 36h  
© Erdman Video Systems, Inc. | 8895 SW 129​th​ Street, Miami, FL 33176 | Tel: 1-888-495-6057 

 



A -101 scene is like the swiss army knife of special operations. You can do the follow operations using a 
-101: 

● Sample the firmware analog to digital converters for temperature and voltage information 
● Trigger one of the two voltage I/O ports (used for windshield wipers, etc) 
● Run command prompts 
● A number of other special applications 

 
The -102 scene is used to plot the analog data captured from -101 scenes 
 
-994 scenes are used for manipulating images before upload IF you want to retain the original image 
sets 
 
-998 and -997 are upload scenes that are similar to the -995 scene but have special purposes such as 
uploading a composite image set or uploading a single file. 
 
VM95 has a number of other functions it can perform. Many of which are beyond the scope of this 
document. Please consult with your Erdman account rep to learn more. 
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